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TopSolid'Split Introduction

Introduction

Philosophy

The TopSolid'Split module provides you with all the tools you need to design the different molding parts
required to create the part to be injected. The splitting operation does not just mean separating a core block
and a cavity block. Thanks to TopSolid'Split you will be able to directly create insert shapes and other cores.

Of course, it is sometimes necessary to use the mold environment to create these types of shapes. Therefore,
you will be able to create these shapes in the second stage of your design process. Both methods complement
each other and this guide will focus on the first stage.

A number of design steps must be performed to produce a final document that contains the different blocks.

Firstly, you have to retrieve a 3D model designed on an external system, or a part or an assembly designed in
TopSolid.

This data is then prepared and positioned in a Split document, by applying a shrinkage factor, and then used
when defining a parting edge path. Wizards will guide you through these design tasks. From this point, you can
design the parting surfaces, the shut off surfaces and the possible inserts required to create the process to
obtain the part.

The final result will be an assembly document that you can manipulate as you wish to design your tooling.

As you can see, you work logically, on a step-by-step basis (see AnnexAnnex chapter), and the next step can
only be accessed if the previous step has been completed and confirmed.

Importing the package
e  From the Home tab, ﬁ import the project named TopSolid'Split Training 7.14.TopPkg. This package

contains all the documents needed to complete all of the exercises in this training guide.

Warning: Do not confuse the \E/% Import Project command (formerly known as Import Project as Replication)
which creates a new project or synchronizes your documents (data exchange between the PDM server and the

local PDM for example) with the Import/Export > N@é Import Package command which creates new documents.
You can only access the latter command by right-clicking on the node (root or folder) of a project. Halfway

betwe_e_n these two commands, the "3/% Import Project as Distinct Copy command (accessible via TopSolid

]
icon 7 > File) allows you to create a new project and thus new documents.

TopSolid 1



Exercise 1 TopSolid'Split

Exercise 1

This exercise introduces you to the basic tools of TopSolid'Split. You will learn how to create simple core cavity
blocks.

Concepts addressed:

- Creating an injection positioning

- Defining a shrinkage without part material
- Creating parting edges and parting surfaces
- Creating core cavity blocks

2 TopSolid



TopSolid'Split Exercise 1

Starting the study

e  From the Project tree, open the remoteCover part document from the Exercise 01 folder.

Creating the injection frame

Note: Most of the time, your 3D model is oriented along a design or mounting frame (automotive part) which
does not correspond to the part's injection frame and to TopSolid'Split's conventions. By default, we will assume
that in a TopSolid'Split document:

- -The section delimited by the XY plane and including Z+ is the A SIDE section (injection).

- -The section delimited by the XY plane and including Z- is the B SIDE section (ejection).

The part position, as the part geometry, must be considered as customer's data that cannot be modified. It is
highly recommended that you create an injection frame on the part that will match the position and orientation
of your part in the future mold.

e From the Construction tab, create a ?g% constrained frame on the part's top face, centered on the four
main edges of the top face.

Support plane:
“ShapehFa(E(ﬂB} v| & |
[] Automatic

Reference frame:

B *]

First constraint
First plane or axis:

Shape 1:Edge(3877, v dk

() Distance

(®) Second plane or axis

Shape 1:Edge(3885 v dk

First plane or axis:

Shape T:Edge(: «
() Distance

(®) Second plane or axis

Shape T:Edge(3202) v H

(®) Orient X
() Orient ¥

(7] shape 1:Edgerzss v | 4 |

o
&
o
E}
o
A
o
E}
&
g,
5
E

Orientation

e % Confirm the constrained frame.

TopSolid



Exercise 1 TopSolid'Split

S

e Right-click on the previously created frame and select the Others > #=> Publish Frame command from the
Selection section.
e Rename the frame Injection.

\)le_i'?

e Publish Frame

Name:

Injection

Description:

Frame 1

Frame:

A Frame 1 v | gk

° M Save the part document.
In TopSolid'Split

Including the part in the Split document

Note: There are several ways to include a part in the Split document:

—
e  Right-click on the part document's tab and select the %‘* Split Blocks command.

%
e  Orright-click on the part document from the Project tree and select the <=~ Split Blocks command.
b
e  Orcreate anew | document, select <=7 Split Blocks, and then @ drag and drop the part document into

the split document from the Project tree.

Here, we will select the first method.

-
e  Right-click on the part document's tab and select the % Split Blocks command.
e  Select Blank Template and click on “” to confirm.

Defining the shrinkage

e In the dialog box that appears, adjust the shrinkage by selecting the Injection frame you previously
published from the list of frames.
e Adjust the shrinkage factor to Global mode and enter 2%.

Shape to transform:

Meolded Shape (remoteCover <1531>) W

Frame:

A Injection <133 (Publishings) | <k

Shrinkage factor:
Automatic

(@ Global

() Differential

Factorn

2%

Mode:

Expansion W

4 TopSolid



TopSolid'Split Exercise 1

Note: In the advanced options, the following two shrinkage modes are available:

- Shrinkage mode: For a given shrinkage factor of 1%, 1% is subtracted from the final dimension. For
example, for a length of 100mm, the result is 101.01 mm after the shrinkage calculation.

- Expansion mode: For a given shrinkage factor of 1%, 1% is added to the original dimension. For example,
for a length of 100mm, the result is 101 mm after the shrinkage calculation.

o % Confirm the shrinkage.
Note: There are three ways to adjust the shrinkage factor:

- Automatic: A material has been assigned to the part in the TopSolid'Design document and, if the
Shrinkage Factor field has been adjusted, this overall value is directly retrieved.

Commen || Advanced | -i
Hardness Elasticity
Brinell Hardness: Young's Modulu
Rockwell A Hardness: Poisson's Ratio:
Rockwell B Hardness: Shear Modulus:
Rockwell C Hardness: Bulk Modulus:
Vickers Hardness: Elastic Limit:
Rheclogy
Shrinkage Factor Cadmould Mater
2 - -306457701

- Global: You can adjust a value which will be applied uniformly according to the three axes of the part
(depending on the previously selected frame). The value can be given in %, %o or as a coefficient (for
example, a shrinkage factor of 2% will give a coefficient of 1.02).

- Differential: You adjust a different value for each axis of the part (depending on the previously selected
frame). The value can be given in %, %o or as a coefficient (for example, a shrinkage factor of 2% will give
a coefficient of 1.02) and be adjusted independently on each axis.

i ey,
(@) Differential

X facton
IN%e

Y facton
4%

Z facton
1,05

TopSolid 5



Exercise 1 TopSolid'Split
Creating the candidate edges

e  From the Split tab, select the % Candidate Edges command. From the Molding axis drop-down list, select
the Z axis of the molded set frame.

» X ?

@ Candidate Edges

Shape:
[[shape To Split (Molded Set 1)~ | < |

Melding axis:
|}I|Frame(rv10|ded Set 1:Z Ais | o ‘

Priority

() Speed

(®) Precision
Filter
(®) Superior
O Al
() Inferior

Precision level (low to high):

e  Click on the P' icon to move to the next step.
Note: The candidate edge creation step is optional. It provides assistance to create the parting edges. You can
create candidate edges several times on the part, based on different directions for example.

Creating the parting edges

e Create the ‘ parting edges. Select the upper path as shown below.

vxi?
Parting Edges

Shape to modify:
“ShapeTo Split (Molded Set 1) v| LH] |

Edges:

Edge(Shape To Split (Molded Set 1):Edc A
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc

| Edge(Shape To Split (Molded Set 1):Ed{ ,,

Candidate edges enly
[] Closed candidates edges only

Planar candidates edges only

e Clickon % to confirm.

6 TopSolid



TopSolid'Split Exercise 1

When confirming the parting edges, the molding areas are highlighted in colors if the parting edges properly
split the part into two sections.

Creating the parting surface

e (Create afirst % parting surface using the \’> Planar mode.
e Select the first edge of the path. The planar path is automatically selected.
e  Adjust the extension length to 50mm.

vxE?

Parting Surface

e

Start edge:
(| shape To Split (Molded Set 1):Edge( « ”

Reverse
End edge:
[ Shepe To Split (Molded Set 1):Edge: |

Parting edges only

Maold frame:

||Opening Frame V| ] ‘

Start extension mode:
| Part ~ |

Start direction:
|7 |
End extension mode:

|Part V|

End direction:

e |
Limit:

| Length ~ |

|5ﬁmm |

o Confirm the parting surface.

TopSolid 7



Exercise 1 TopSolid'Split
®* . . ®» .
e C(Create asecond parting surface using the Extension mode.

e Select the start edge and the end edge as shown below, and then select Automatic to calculate the
extension direction.

vxXER?

Parting Surface

Bl %

Crr——

Start edge:
([shape To Split (Molded Set 1:Edget - |

[] Reverse
End edge:
|| Shape To Split (Molded Set 1):Edgef: ~ ||

[+] Parting edges only

(3 —

Mcld frame:

|‘ Opening Frame V| L1 |
Direction:

@ Automatic

() Manual

- 7]
Limit:

| Length ~ |

|5{)mm |

[] Draft:
B |

Lateral extension:
[ At start
[ Atend

4’ Confirm the parting surface.

Repeat the procedure to create the opposite side surface.
e (Create a new ‘@ parting surface using the o Extension mode. Select the remaining edge path. Double-
click on the yellow spheres of the parting surface's side edges to create the lateral extensions.

v 3?2

Parting Surface

Ble ¥

Crr—

Start edge:

”ShapeTo Split (Molded Set 1):Edgefs ~ ||

[] Reverse
End edge:
|[shape To spit (Molded Set 1):Edget: ~ |

[ Parting edges only

(3 rrr—

Meld frame:

|‘Opening Frame v| 2k |
Direction:

(® Automatic

) Manual

[z ]+]
Limit:

| Length ~ |

| 30mm |
[] Draft:
r |

Lateral extension:
[ At start
[ At end

8 TopSolid



TopSolid'Split Exercise 1
Creating the parting shells

e Select the % Parting Shells command.

Note: Dragging the slider in the Opening area moves the shells according to the mold opening. Selecting one of
the shells in the list allows you to move only this shell.
v ¥ ?

,, Parting Shells

Opening:
v

Shells
Shape 3
Shape &

®

e % Confirm the creation of the shells.

Creating the parting shapes

e Select the @ Parting Shapes command.

Note: Dragging the slider in the Opening area moves the shells according to the mold opening.

v X ?

@ Parting Shapes

Cpening:

Shells Blocks
Shape 5 Cavity block
Shape & Core block

e Clickon % to confirm.

TopSolid 9



Exercise 1 TopSolid'Split
Creating the core cavity blocks

A
v 14
e Select the ~ & Core Cavity Blocks command and adjust the parameters as indicated below.

v X ?

@ Core Cavity Blocks

Derived parts:

Shapes Parts Type
| remoteCover.Cavity block Core cavity block ~
Core block remoteCover.Core block Core cavity block ~
Shape With Shrink (Molded Set 1) rermoteCover.5Shape With Shrink (Melde... | Shape with shrink ~

o % Confirm the creation of the core cavity blocks.
e  Select the destination folder.

Note: When creating the core cavity blocks, several documents are automatically generated for the PDM.
Indeed, in a PDM, a part corresponds to a file.

You will always find the following documents:

- A part document for the part with shrink. It is the customer's part with the shrinkage. This part will be
used to design the mold and will limit the molding elements (the pins for example).

- A part document for each block.

- Astandard assembly document. The assembly is mounted with the different parts created automatically.

e  From the Project tree, right-click on the Exercise 01 folder and create three . sub-folders named 01-
Customer part, 02-Split and 03-Core cavity blocks.
e Hold down the Ctrl key and select the remoteCover assembly document and the part documents for the

core cavity blocks and the shape with shrink. @ Drag and drop this selection into the 03-Core cavity blocks
sub-folder.

e Inthe same way, rearrange the remaining documents as shown below.

B i Exercice 01 5 + Exercize 01
-4 2% remoteCover ==

remoteCover
remoteCover |”] E|
remoteCover.Cavity block

remoteCover.Core block -
remoteCover.Shape With Shrink (Molded Set 1)

| 01-Customer part

-ds [ remoteCover
| 02-5plit
-k 2% remoteCover
03-Core cavity blocks

-4 | remoteCover

-4k [ remoteCover.Cavity block

- & [ remoteCover.Core block

= remoteCover.Shape With Shrink (Molded Set 1)

e e A e R B R

Check-in

P )

e  Fromthe Project tree, right-click on the Exercise 01 folder and select the ¥ Check In command. This action
checks all the documents contained in this folder into the vault.

10 TopSolid



TopSolid'Split

Exercise 2

Concepts addressed:

- Defining a material with a predefined shrinkage value and applying the shrinkage to the part
- Adjusting the standard stock

- Creating shut-off surfaces

- Creating lofted parting surfaces

- Updating all documents created in TopSolid'Split

- Visualization in the assembly

TopSolid

Exercise 2
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Exercise 2 TopSolid'Split
Creating a standard material

Creating a user library

e  From the ¥ TopSolid > File menu, create a \_} new library using a blank template and rename it My
standard.

e Clickon % to confirm.
Note: This is the general method to create a user library. The user library can contain all types of standard
elements such as standard materials, components, etc.

Defining the material

e  Right-click on the library name and create a new __| document

e  From the Advanced tab, select a * Material document and use a blank template.
e  Enter the material characteristics as indicated below.

Common Advanced | Common Advanced
Bl of material PP ess Elasticity
Das:""V Part Number: 0.9kg/dm3 Young's modulus: Elongation ot breakc

C e Density: / Rockwell A hardness: Poisson's ratic: Section reduction at break:

Unclassified | (|o9kg/dm3

Appearance

Rockwell B hardness: Shear modulus: Plastic strain ratio:

Texture:
S Rockwell C hardness: Bulk modulus: Ultimate stress:

Diffuse color: Vickers hardness: Elastic limit:

Bump texture:
Rheology
v
Shrinkage factor: Cadmould material identifier
B I
ump scale:
Specularity type: Reflection coefficient Transparency coefficient \
None v X X
Specular shininess: Reflection spreading angle: Refractive index
40% x
Specular spreading: [ Fresnel reflection Refraction spreading angle:
5% Receive shadows
Specular color: Cast shadows
<unspecified> x

e From the library tree, rename the material document PP.

e U Check the library into the vault.

Referencing the library
e  Return to the TopSolid’Split Training project, then right-click on the References node and select the

¥ Reference Library command.
e  Open the My standard library you previously created.

Starting a new design

e  From the Project tree, open the radiusPart part document from the Exercise 02 folder.

12 TopSolid



TopSolid'Split

Assigning the material to the part

e  Open the My standard library.

Exercise 2

e Dragand drop the material document into the part document's graphics area.

-

e  From the Tools tab, open the document's !

calculation.

v X ?

physical properties and select Automatic for the mass

Physical Properties M...

Automatic

(® Automatic
() Manual:

() Not managed

The properties defined on the part are listed in the Entities tree. You can find the material and the mass applied

to the part.

|_:_|J Parameters

TopSolid

-4y Material = PP
-7 System Parameters

----- od, Comment = <unspecified=

----- of, Description = "@45"

----- pbe Code = <unspecified=

----- gbe Part Mumber = <unspecified>

----- #oe Manufacturer = =unspecified»

----- gbe Manufacturer Part Mumber = <unspecified»
----- gpe Complementary Part Number = <unspecified>
----- 6T Standard = 150

----- od, Mame = "radiusPart"

----- #oc Major Revision = "A"

----- goe Minor Revision = 0"

----- pbe Author = "LOCAL"

----- Ef Modification Date = 20/07/2020 08:44:59

----- ‘;.f Creation Date = 26/07/201% 13:24:15
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Exercise 2

Defining the shrinkage

TopSolid'Split

e Right-click on the part document and create a g Split document using a blank template.

The shrinkage is automatically provided by the material assigned to the part.

e Clickon % to confirm.

Adjusting the standard stock

o
[ Shrinkage1

Shape to transform:

“Molded Shape (radiusPart < ~ ”

Frame:

||Ir1jection 159> (Pr | & |

Shrinkage factor

(@ Automatic

O Global

() Differential

Factor: 1,8% (PP)
|radiusPart5'Shrink,age Factor' |

@ Advanced Options

Mode:

| Expansion ~ |

A stock is automatically generated for the core cavity blocks when creating a split document. By default, it is
centered on the Molded set frame and may not correspond exactly to what you want.

e Select the A Stock command to edit the stock.

e  Center the stock by creating an Q< offset frame using the & special inputs.

v X?
Stock
LA

Xlength:
|162mm |

Y length:
[121mm |

Z length:
[192mm |

Opening frame:

||F'amE(Molded Set 1) v| & |

| Automatic... |

e  Offset the absolute frame along the absolute Z axis by 20mm.
o % Confirm the offset frame.

14

Reference frame:

[Zpwstscrome ]

Offset direction:
‘ Absolute Z Axis | & ‘
Offzet distance:
|P_Clmm |

TopSolid



TopSolid'Split Exercise 2

The Automatic mode offers stock dimensions suited to the part. In the advanced options, the Show planes
option displays the planes linked to the stock. These planes will be used to dimension the parting surfaces

automatically.
v x?
g€

Xlength:
|162mm |

¥ length:
[121mm |

Z length:
[102mm |

Opening frame:

I|Frame1 V| qr |

| Automatic... |

@ Advanced Options

Regenerate planes

Extra length:
| 10mm |

[] Show planes

« Confirm the stock.

Note: To modify the default stock in the split document, you can either select the - Stock command, or edit

the Stock operation from the Operations tree in the parting stage ?!?3
Creating the parting line
Creating the candidate edges

e Select the % Candidate Edges command. From the Molding axis drop-down list, select the Z axis of the
molded set frame. Select the Precision mode and filter the inferior edges.

» X adj ?

@ Candidate Edges

Shape:

“ShapeTo Split (Molded Set 1) v| dh ‘

Maolding axis:
| A Frame (Molded Set 17 Axis v |
Priority
() Speed
(®) Precision
Filter
(O Superior
Q Al
(®) Inferior

Precision level (low to high):

° [#’ Move to the next step.

TopSolid 15



Exercise 2 TopSolid'Split
Creating the parting edges

Note: We recommend that you generate several ‘ Parting Edges operations rather than one. It will be much
simpler to modify and update the parting edges later.

e Create the ‘ parting edges by selecting the part's external path.

e C(Click on 4 to confirm.

Note: The molding areas are not colored since the generated parting edges do not yet properly define the
parting line.

e C(Createthe ‘ parting edges for the three lower edges of the openings to the left of the part.

e Click on % to confirm.

Note: The Candidate edges only option allows you to filter the part edges when selecting the parting edges
using a selection box.

e  Orient the part in order to draw a selection box around the parting edges that remain to be created.
vxi?
Parting Edges

Shape to modify:

([shape To Split (Molded Set 1) | ‘

Edges:

Edge{Shape To Split (Molded Set 1):Edc &
Edge{Shape To Split (Molded Set 1):Edc
Edge{Shape To Split (Molded Set 1):Edc
Edge{Shape To Split (Molded Set 1):Edc
Edge{Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc
Edge(Shape To Split (Molded Set 1):Edc

| Edge(Shape To Split (Molded Set 1):Edg ,,

Candidate edges only
Closed candidates edges only
[] Planar candidates edges only

e Clickon 4 to confirm.
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TopSolid'Split Exercise 2

This time, the molding areas are highlighted in color.

Note: The order in which the % shut off surfaces or the ﬁ/ parting surfaces are created is not important to
split the part.

Creating the parting surfaces

e Create the Q/ parting surfaces for the four rounded sides by selecting the R Extension mode and the
Stock plane limit mode.
S ¥ Jr; ?

@ Parting Surface

Be ¥

Start edge:

|Shape To Split (Molded Set 1):Edge(: v|

Reverse
End edge:

Shape To Split (Molded Set 1):Edgel} ~

Parting edges only

Mold frame:
A |Opening Frame v| ok

Direction:
(@) Automatic
) Manual

/H

Linmit:

Stock plane ~

Stock Y- Plane

] Craft:

0

Lateral extensicn:
[] At start
[]Atend

TopSolid 17



Exercise 2 TopSolid'Split

Note: For the two parting surfaces on the part width, make sure you select the small fillets on the edge path.

e C(Click on Q? to confirm.

e C(Close the external parting line by creating four parting surfaces using the " Lofted with guides mode.

Select \>> Corner as the closing type.
vXx3?
@ Parting Surface

&% s

Start edge:

||Shape To Split (Molded Set 1):Edge( -~ ”

Reverse
End edge:

Parting edges only

Start profile:
| A shape 2Edge(30) ] ‘

End profile:
|;l (Shape 4:Edge(30) v| & |

Closing:
> A

Closing Profile:

e (Click on Q? to confirm.
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TopSolid'Split Exercise 2
Creating the shut off surfaces

e (Createthe % shut off surfaces. To do this, select the % Shape mode and select the part in the graphics
area. In the Edges to ignore field, select a bottom edge of the part so that no shut off surface is created
here.

vx§a?

See

Shape:

|ShapeT0 Split (Molde: v| &

Edges to ignore:

| Shape To Split (Molded Set 1]

Note: TopSolid tries to automatically create as many surfaces as possible. In our case, all the surfaces are
created.

Creating the shells, the parting shapes and the core cavity blocks

Creating the parting shells

e Create the % parting shells.

e Click on % to confirm.

TopSolid 19



Exercise 2
Creating the parting shapes

|3
e C(Createthe @ parting shapes.

e Clickon % to confirm.

Creating the core cavity blocks

O :
e C(Createthe k& core cavity blocks.

Derived parts:

TopSolid'Split

@ Core Cavity Blocks

Shapes Parts Type
radiusPart.Core block Core cavity block
Cavity block radiusPart.Cavity block Core cavity block
Shape With Shrink (Molded Set 1) radiusPart.Shape With Shrink (Molded Se... | Shape with shrink

e Clickon % to confirm.
e Indicate where you want to create the core cavity blocks.

Check-in

e )

e  From the Project tree, 2 check the Exercise 02 folder into the vault.

20
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TopSolid'Split Exercise 2
Update
Modifying the part geometry

&
e  Fromthe Project tree, right-click on the U assembly document named radiusPart and select the Life Cycle
(A- Design) > ¢ Validate command. All the related documents are also validated.

e From the Project tree, enable the 12 Show revisions icon and expand the Revisions node for each
document.

=) + | Exercise 02
|_:_| g E radiusPart
E| Revisions
- @ i A (Validated)
7 8 P radiusPart
E| Revisions
w- @ Y A (Validated)
- @ lg radiusPart
E| Revisions
@ @ i A (Validated)
- & I radiusPart.Cavity block
E| Revisions
- & Y A (Validated)
=- & I radiusPart.Core block
E| Revisions
w- & Y A (Validated)
- & I radiusPart.Shape With Shrink (Molded Set 1)
£ Revisions
- 8 “Ey A (Validated)

m

m
(L)

e  Return to the part document.

° @ Remove the faces of the part's two holes by selecting the Extend heal type.

T

Y Removing

@a@f&

Faces to remowve:

Face[Forme 1:Face[2832
Face(Forme 1:Face(2556 o
Face(Forme 1:Face[2833
| Face(Forme 1:Face(2544

[] Keep faces

Heal type:
| Extend ~

TopSolid 21
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TopSolid'Split

e  Select the g Drilling command and create a % constrained frame using the HF special inputs.

@ Constrained Frame

Support plane:

| Shape 1:Face(458f | dp ‘

Automatic

Reference frame:

[ ¢

First constraint

First plane or axis:

(] sureresen <]

(®) Distance

() Secend plane or axis

|1Smm |

Second constraint

First plane or axis:

‘ Shape 1:Edge(f | 40 |

(@) Distance

() Second plane or axis

|'.-'mm |

§ up
Create a @5mm ~ through hole.
Click on % to confirm.

'l" - .
Repeat the previously created drilling to create a second drilling using a *~ symmetrical pattern in
relation to the absolute XZ plane.

v X ?

Symmetry type:

@ Symmetrical Pattern

|Phne

Y

Plane:

Absolute ¥Z Plane w | gp

Transforms type:

|Symmetr}r

®

When you are finished modifying the geometry, you obtain the following result.

EIE" radiusPart™

E El—_ Revisions
-4 ‘iz A(1) (Design)
w- & Ui; A (Validated)

TopSolid



TopSolid'Split Exercise 2

° H Save the document. This action creates a new version of the part.
G P
= Revisions
: G-k ‘iz B (Design)
- & YEr A (Validated)

Note: You can define the default names of the major and minor revisions by right-clicking on the project name

and selecting the Others > "= Default Revision Texts command. You can also choose whether or not to
increment the major revision names automatically.

*i= Default Revision Texts O o

First named major revision text:

|A

Mame first major revisicn

First minor revision text:

| 0

Increment automatically major revision text

v ¥ ?

Check-in

o )

e  From the Project tree, = check the radiusPart part document into the vault.

Split update

e Openthe g radiusPart Split document.

A message appears, warning you that the split document is not redirected to the last major revision of the part.

' TopSolid *

Document has some references not redirected to last major revisions, Do you want to
#  update?

Yes Mo

e (Click on Yes to redirect the split document to the new part revision.
e Click on the " icon to redirect all references.

The update causes some items to be invalid that are shown in the following error messages.

/ TopSclid K |« TopSelid x
I Parting 5tage/ Candidate Parting Edges 1 0 Parting Stage / Parting Edges 2
 Some edges have been removed. Some edges are missing.

e  (Click on OK to confirm the messages.

TopSolid 23



Exercise 2 TopSolid'Split

The split document is then invalid. [E'Mi“ 0' ]

Note: Clicking on the 0 icon allows you to identify what the problem is: the parting edges of the former holes
are no longer recognized.

X ?

o Parting Edges 2

Shape to modify:
|5hapETo Split (Molded Set 1) v| gr

Edges:

Edge({Shape To Split (Molded ! A
Edge(Shape To Split (Molded
Edge({Shape To Split (Molded !
Edge(Shape To Split (Moelded !
Edge{Shape To Split (Molded ! '0
Edge({Shape To Split (Molded !
Edge({Shape To Split (Molded !
Edge(Shape To Split (Molded !

[] Candidate edges only
Closed candidates edges only

Planar candidates edges only

e Inthe dialog box, right-click and select the Delete Invalid Selections command.
e  Select the edges of the new drillings instead.

e  (Click v to confirm.
° B Save the document.

e  Update the parting shells by clicking on the 0 icon in the document's tab or by selecting the % Parting
Shells command.
o Clickon * to confirm.

e Once the parting shells have been updated, you are requested to update the % parting shapes.
o Clickon % to confirm.
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TopSolid'Split
Updating the assembly

]
e Openthe D radiusPart assembly document. The following message is displayed.

«/ TopSolid

Document has some references not redirected to last major revisions. Do you want to
@  update?

x

e Click on Yes to redirect the assembly document to the new split document.
o Clickon % to confirm.

The assembly is then updated.

/

Py
e " Check the Exercise 02 folder into the vault.

A B revision has been created for each document.

= @ | Exercise 02
= & 5 radiusPart
-7 Revisions
& ‘i, B (Design)
& %y A (Validated)
- & I radiusPart
£ Revisions
- & iy B (Design)
G- & Uiz A (Validated)
= & k radiusPart
- Revisions

@ & iy B (Design)

G- & Uiz A (Validated)
=& P radiusPart.Cavity block
- Revisions

& “t; B (Design)

G- & Uiz A (Validated)
(=] ' radiusPart.Core block
- Revisions

& “i; B (Design)

& ‘g A (Validated)
=& I radiusPart.Shape With Shrink (Molded Set 1)

|é_|--—_" Revisions

- & iy B (Design)
G- &y A (Validated)

i}
L

TopSolid
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Exercise 3

Exercise 3

Concepts addressed:

26

Defining a differential shrinkage
Positioning the part

Creating a user stock

Creating automatic parting surfaces
Creating an interlock parting surface
Creating insert surfaces

Managing the different parts
Updating the assembly

TopSolid'Split
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TopSolid'Split Exercise 3

Starting the study

e  From the Project tree, open the coverTShape part document from the Exercise 03 folder.

Defining the differential shrinkage

b
e  Right-click on the part document and create a <=7 Split document using a blank template.
e  Apply a differential shrinkage and enter the factors as indicated below.

o as 2

Y
- .

Shape to transform:

|MOIded Shape (coverTShap v|

Frame:

|/"l Injection <158 (P1 | & |

Shrinkage facton
Automatic

() Global

(@) Differential

X factorn:

1,02

Y factor:

1,02

Z facton:

1,015

e  Click on % to confirm.

Note: The shrinkage values according to each axis of the reference frame can be expressed independently of
each other in %, %o or as a coefficient.

Positioning the part

e  Right-click on the part in the graphics area and select the 4‘“»\; Edit Positioning command.

You will notice that the part already has a frame-on-frame constraint with the published frame as the source
frame and the absolute frame as the destination frame.

[-Z[Frame on Frame 1

e  Confirm the positioning.

TopSolid 27



Exercise 3 TopSolid'Split
Creating a user stock
Defining a standard stock

e Selectthe ® Stock command. The automatically created stock does not correspond to the stock we want
to split.

e 4 Confirm to exit the command.
Creating a user shape

e  From the Operations tree, move the insertion cursor under the - Stock operation.

EH-% Stock

-h Parting Stage
-9 Shape To Split 1
- T .

e  Create a 2D sketch on the absolute XY support plane.
e  Draw arectangle and set the following dimensions and constraints.

180

55

=150=

e C(Createan (’ extruded shape of 80mm and center it.
2.5

Section:

@ sketeh 1 v| @ |

Directicn:

‘|Sketch‘| v| @ |

Limit:

Length ~

= |
Center
[] Draft:
" |

Offset limit:

|'Imm |

[ Surface

28 TopSolid



TopSolid'Split Exercise 3
Defining a user stock

—
e  Right-click in the graphics area and select the % End inserting command. You can also click on the
—
&’ icon in the Split document's tab.

e Edit the A Stock operation. Select the G User option and select the previously created block.
v % ?

e Stock
e

Shape:
| Shape 1 ~ | gn

Opening frame:

Frame(MoIded Set1) | db

o Clickon % to confirm.
Creating the parting line
Creating the candidate edges

e Createthe % candidate edges. From the Molding axis drop-down list, select the Z axis of the molded set
frame.

° ?" Move to the next step.
Creating the parting edges

e Createthe ‘ parting edges. Select the external path of the part as shown below.

e Clickon L4 to confirm.

Note: The molding areas are not colored. The parting edges you just created do not properly define the parting
line.
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Exercise 3

TopSolid'Split

e Createa % parting edge for the part's central opening.

Click on % to confirm.

e

Note: The molding areas are colored since the parting edges now properly define the parting line.

Creating the shut off surfaces

e  Select the % Shut Off Surfaces command and create the following surface using the s Face mode.

30

v X Rag?

*ee

Face:

||ShapeTo Split (Molded Set 1):Face( ||

Edges to ignore:

[1Internal parting edges
Use complete parting edges

g g

[] Invert extension side

TopSolid



TopSolid'Split Exercise 3
Creating the automatic parting surfaces

e Select the @ Automatic Parting Surfaces command and click on the Compute surfaces button.
vX3?

@ Automatic Parting Surfaces

Shape with shrink:
“Shape To Split (Molded Set 1)

Mold frame:

‘|Opening Frame

Limnit:

| Stock plane

Parting lines:
S5

Line 1

[] Automatic update

Compute surfaces...

Surfaces Prierity:

|Planar

Surfaces:

Planar

Planar

Planar

Planar

Planar

Extension

Extension

R EERE R EE]

Extension

|

e  Click on % to confirm.

All the surfaces are automatically created. However, you can edit them if necessary.
Creating the parting shells

e Create the % parting shells.

There are some errors on both shells. The invalid edges are displayed in red on the two shapes.

e  Click on % to confirm.
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Creating the interlock parting surface

e  Select the % Interlock Parting Surface command to create a complex parting line.

e  Select the \‘> Section mode and create a new 2D sketch using the 5 special inputs.

32

Draw the following contour.

(Z e —

Support plane:
| Absolute XY Plane v | dh

Crigin point:

Opening Frame L]

(") Horizontal direction (X):
(@) Vertical direction ():

A Absolute Y Axis v | gp

R20

R20

R20

R20

Confirm the sketch.

TopSolid'Split
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TopSolid'Split

Exercise 3

In the Destination Plane section, select the flat face of the bottom parting surface and enter a draft angle

of 10°.

v X ?

Interlock Parting Surf...
R

Section:

[ = |sketen2 NE: |

Destination Plane

Plane:

‘ -Shape %:Face(27) ~ |k ‘
Extrusicn direction

(® Destination plane
(O Manual

Draft angle:
o |

Click on % to confirm.

Creating insert surfaces

TopSolid'Split does not only generate the core cavity blocks. During the split operation, you can also create the
inserts related to the split design.

Face mode

e (Createthe s insert surfaces for the two symmetrical cylindrical pins.

e Select the 0 Faces mode and select the faces of the area to be molded by the insert. Select Stock plane

as the limit.

v ¥R af?

Shape with shrink:

0 Insert Surfaces

“ShapeToSpIit (Molded Set 1) v| & ‘

gad

Face(Shape To Split (Molded Set 1):
Face(Shape To Split (Molded Set 1):f
Face(Shape To Split (Molded Set 1):
Face(Shape To Split (Molded Set 1):f

| Face(Shape To Split (Molded Set 1):

Limit:

|’Stock plane

‘ Stock Z- Plane

Direction:
(@) Automatic
() Manual

|2

[ Follow draft

TopSolid
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Exercise 3 TopSolid'Split

Note: You can use multi-selection to create several insert surfaces at the same time.

e Select Automatic as the direction.

« ¥ Confirm the creation of the insert surfaces.

Profiles or loops mode

e Select the 3 Profiles or loops mode for the other two cylindrical pins.
o  Select the profile of the future insert by selecting an edge of the part.

v X }a?

e Insert Surfaces

Shape with shrink:
|Shape To Split (Molded Set 1) | &

237G

Shape To Split (Molded Set 1):Edge(
| Shape To Split (Molded Set 1):Edge(

Lirnit:

Stock plane ~

Stock Z- Plane

Direction:
(®) Automatic

) Manual
,ﬂ

[] Follow draft
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TopSolid'Split Exercise 3

Note: To ensure the creation of an insert during the split process, you must create parting surfaces. TopSolid
also needs to define a molding area for this insert. To do this, parting lines are necessary.

When creating an insert surface, if these parting lines have not been defined beforehand, TopSolid will create
them automatically.

e  Right-click in the graphics area and enable the % Display Parting Edges and &% Hide Parting Surfaces
commands.

Note: You can also quickly show or hide the Split geometries using the icon bar at the bottom right of the

graphics area.
DeLYeRE

. & Hide/Show Shapes to Split
A

. Hide/Show Stock

- ¥ Hide/Show Parting Surfaces

- % Hide/Show Parting Shells

- @ Hide/Show Parting Shapes

- % Hide/Show Shapes With Shrink

A parting edge has been generated for each insert surface and a new colored area is created.

Note: Four predefined colors in the Tools > (U Options command are used to define the molding area mapping.
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Exercise 3 TopSolid'Split
Updating the parting shells and parting shapes

Parting shells

e  Recreate the % parting shells to take the newly created surfaces into account.

W ® ?

,, Parting Shells Management

Opening:

Shells 2
Shape 11
Shape 12
Shape 20

Shape 21

®

e  Select the four insert shells so that they can move simultaneously. You can use the Shift and Ctrl keys on
your keyboard to make selection easier.
e Click on % to confirm.

Parting shapes

-

e Selectthe @ Parting Shapes command to create the parting shapes. This operation creates the core cavity
blocks and the four inserts.

e  Rename the insert shapes by double-clicking on the name of the shape to be modified.

v X2
@ Parting Shapes
Cpening:

Shells Blocks £
Shape 11 Core block
Shape 12 Cavity block
Shape 20 Insert
Shape 21 Insert 1
Shape 22 Insert 2 v

®@

e Clickon % to confirm.
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Creating the core cavity blocks

% K]
e Select the \lzﬁ' Core Cavity Blocks command.

The name of each part becomes the name of the created file.

v X7
Derived parts:
Shapes Parts Type
Core block coverTshape.Core block Core cavity block
Cavity block coverTshape Cavity block Core cavity block
Insert coverlshape.lnsert Insert
Insert 1 coverlShape.lnsert 1 Insert
Insert 2 coverlshapelnsert 2 Insert
Insert 3 coverTshape.nsert 3 Insert

e Click on % to confirm.

e Indicate where you want to create the core cavity blocks.

Creating the central insert

e Inthe CoverTShape split document, return to the

A

parting stage to create a new insert.

Exercise 3

e (Createan ‘ insert surface using the 0 Profiles or loops mode based on the external edge of the center

shape.

e Select an automatic extrusion direction.

e Click on % to confirm.

TopSolid
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Exercise 3 TopSolid'Split
Update

Parting shells

Whenever a change occurs to the parting surfaces or the insert surfaces, you need to recalculate the parting
shells.

e  Select the % Parting Shells command.

e C(Click on < to confirm.
Parting shapes

L
e Inthe same way, recalculate the @ parting shapes. You can observe that a new shape has been created
and you can rename it.
e Click on % to confirm.

Core cavity blocks

O3 ,
e  Recreate the & core cavity blocks.
e Click on % to confirm.

Note: When a new shape is created at the block split level, this shape is not automatically derived to create a
q

. A\ L4 . .
new part. In this case, you need to relaunch the & Core Cavity Blocks command to generate this part. The
existing parts remain in place and only the new part is created.

Check-in

e  From the Project tree, = check the Exercise 03 folder into the vault.
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Exercise 4

Concepts addressed:

TopSolid

Creating a cylindrical stock
Creating silhouette edges
Imprinting edges on the fly
Handling parting edges
Creating edges on the fly
Modifying the inserts

Exercise 4
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Exercise 4

Starting the study

From the Project tree, open the Connector part document from the Exercise 04 folder.

Defining the shrinkage

e  From the part document, create a g Split document using a blank template.

Apply a global shrinkage of 1.015.

Click on % to confirm.

Creating a cylindrical stock

40

Select the A Stock command.

Select the Cylinder mode and enter the following values.

v X ?

s8¢

Diameter:

Vi ?

Shrinkage 1

Shape to transform:

||Mo|ded Shape (Connector <157> ~ ”

Frame:

||Injectior1 <159> (Publishi + | & |

Shrinkage facter:

Automatic
@ Globl
() Differential

Factor:

|1,{:15

|60mm

Length:

|‘35mm

Cpening frame:

||Frame(MoIded Seth) ~| & |

| Automatic...

Click on % to confirm.

TopSolid'Split
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Creating the candidate edges

Default candidate edges

e (Create e candidate edges on the part along the Z axis of the molded set frame.

» X o ?

@ Candidate Edges

Shape:

|| shape To Split (Molded Set 1) | & ‘

Molding axis:

| 7 [Frame (Molded Set 1)Z Axis v ] 4 |
Pricrity
(®) Speed
() Precision
Filter

Superior
All

Infericr

Precision level (low to high):

e C(lick on the *’ icon to confirm the edge creation.

e Click on the X icon to cancel the creation of the parting edges.

TopSolid

Exercise 4
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Exercise 4 TopSolid'Split

e  Select the % Candidate Edges command again and select the Y axis of the molded set frame.
» % i ?

@ Candidate Edges

Shape:

“ShapeTo Split (Melded Set 1) v| dh ‘

Melding axis:
| 7| Frame Molded Set 1):¥ Axis v |
Pricrity .
() Speed
(®) Precision
Filter
() Superior
@® Al
() Inferior

Precision level (low to high):

Note: It is necessary to have physical edges on the part to be able to create candidate edges or parting edges.
Therefore, you may need to create these edges if they are not designed on the part.

Creating the missing edges by imprint process

e  Create a sketch on the XZ plane.

e  Select the “ Silhouette command.

v X 3a?

Shape:

Shape To Split (Molded ! ~ | db

Direction:

| Sketch 1 | dn

[] Merge

e Click on % to confirm.
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e Delete some segments and add constraints to obtain the following two profiles.

e  Confirm the sketch.
Creating the parting edges

e  Select the ‘ Parting Edges command and select the edges as shown below.

e Clickon \f to confirm.
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TopSolid'Split

o  Select the % Parting Edges command again.

Click on the ¥ special inputs and 5 imprint the previously created sketch on the visible faces.

v % e ?

e Imprint

Shape to modify:
| Shape To Split (Molded Set 1) |

= | 4+, =
| s J

Sections:

Sketch 1 |

Direction
(@ Crthegonal

() Specified

@ Advanced Options

Hidden faces:
Shape ~

Connection of imprinted edges:
None ~
Imprint precisicn:

Accurate v

Select as parting lines

” Confirm the imprint operation.

Q? Confirm the creation of the parting edges.

You will notice that the parting edges do not allow the molding areas to be properly split. The "inner shell" of
the part is the same color as a section of the "outer shell" of the part.
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e To determine the missing parting edges, select the % Analyze Parting Edges command from the Analysis
tab.
e Select a start face (the end face as shown below, for example) and drag the cursor gradually to the right.

v ?

@ Analyze Parting Edges
Starting face:

[[shape To Split (Molded Set 1):Face(321) |

Progress:

The faces are displayed in red in the graphics area. You only have to identify the area in which the red color
spreads over the faces of the part.

° Q? Confirm the analysis.
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Modifying the part geometry

e  From the Shape tab, select the g Faces Modification command.
Select the face to be moved, then adjust the direction and value as shown below.

The hole has been filled in.

° B Save and close the Connector part document.

46

Open the Connector part document.

v K 0 ?

v

Faces:

@ Faces Modification

| Face{Forme 1:Face{1394)

WOR

Direction:

‘Absolu‘teXAuis v| ‘

Value:

|'D,1mm

Click on \f to confirm the operation.

TopSolid'Split

TopSolid



TopSolid'Split
Creating the parting surface

Extension parting surface

e  Return to the Connector split document.

e Createa Q parting surface using the & Extension mode based on the part's side edges.

v¥xR?

Parting Surface

B %

Start edge:
|Shape To Split (Molded Set 1):Edge(; |

[+] Reverse
End edge:
Shape To Split (Molded Set 1):Edge(:

[+] Parting edges only

Mold frame:

| Opening Frame v| qp
Direction:

(® Automatic
(1 Manual

v|
Lirnit:
|Stocl: plane w |

Stock X+ Plane v | dh

[] Draft:
o |

Lateral extension:
[] At start

[]Atend

o Clickon % to confirm.
e  Repeat the operation with the opposite edges.

TopSolid

Exercise 4
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Planar parting surface

e Createa @ parting surface using the \\’/ Planar mode for the part's bottom section.

48

vxE?
Parting Surface

Rty &

Start edge:
“ShapeTo Split (Molded Set 1):Edge(, ~ ||

[ Reverse
End edge:
||ShapeT0 Split (Molded Set 1):Edge(. ||

[ Parting edges only

Meld frame:

‘|Opening Frame V| LH] ‘

Start extension mede:

| Part ~ |
Start direction:

2 A+
End extension mode:

| Part ~ |
End direction:

2 ]+
Limit:

|Stock plane ~ |
‘ Stock Y- Plane v | dR ‘

Click on 4 to confirm.

Repeat the operation based on the top parting edge.

TopSolid'Split
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Shut off surface

e Createa % shut off surface using the ‘ Shape mode.

v X Eka?

Erurrr——
e

Shape:
“ShapeTo Split (Molded Set 1) v| L ‘

Edges to ignore:

Click on 4 to confirm.

Insert surfaces

e Createan ‘ insert surface using the 0 Profiles or loops mode to create the bottom pin.

v X Eaw?
(P r=rrrr——

Shape with shrink:

|Shape To Split (Molded Set 1) | 4

Qed

Shape To Split (Molded Set 1}:Ed.gei

Limnit:

Stock plane ~

Stock Z- Plane L1

Direction:
(@) Automatic

() Manual
A L]
[ Follow draft

e Clickon 4 to confirm.

TopSolid
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e  Repeat the operation to create the top pin.

Creating the core cavity blocks

Parting shells

e Create the % parting shells.

-l

o

-
1

e Click on % to confirm.
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Parting shapes

e  (Create the % parting shapes.

v X ?

@ Parting Shapes

Cpening:

y

Shells Blocks &
mndion insert
Shape 1 Action insert 1
Shape 12 Core block
Shape 13 Cavity block
Shape 14 Insert
Shape 13 Insert 1 W

e Click on ¢ to confirm.
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Core cavity blocks

o ,
e Createthe k& core cavity blocks.

v ¥ ?

@ Core Cavity Blocks

Derived parts:
Shapes Parts Type
m Connector.Core block Core cavity block v
Cavity block Connector.Cavity block Core cavity block v
Action insert Connector.Action insert Action insert W
Action insert 1 Connector.Action insert 1 Action insert W
Insert Connector.Insert Insert W
Insert 1 Connector.Insert 1 Insert v

TopSolid'Split

Click on L 4 to confirm.

Modifying the insert surfaces

52

_A
From the split document, right-click on the bottom pin and select the 0@ Show Only command.
Create a sketch on the flat face at the end of the bottom pin. Draw a @émm circle centered on the pin's
axis.

Create a % boss with the following settings.
v K o0 ?

Boss

Shape to modify:

|Insert1 v|

Section:

. [sketeh 2 v | &

Direction:

A [sketeh 2 ME:
Lirnit:

Height v/

|5mrr1 |
[] Center

Draft:
5 |

Offset limit:

|1mm |

[] Extends below

Click on 4 to confirm.

@ Show the parting shapes.

A
Hold down the Ctrl key and select the top and bottom pins, then right-click and select the u@ Show Only
command.

TopSolid
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e Createa O Boolean operation using the c Subtraction mode. Enter a clearance of 0.5mm.

v K e ?

Shape to modify:

||nsert

> ‘

vg®

Tools:

Insert 1

Clearance:

0,3mm

] Direction to through:

| dh

° glick on ‘f to confirm.
° % Show the parting shapes.

TopSolid

Exercise 4
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e  Select the : Faces Modification command and use the Move mode to obtain the following result.

@ Faces Modification
=

Faces:

| Face(lnsert 1:Face(244)) ok

it

A Absolute Z Axis ~ | b

Walue:
|'I],5mm |

Check-in

e  From the Project tree, '8 check the Exercise 04 folder into the vault.
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Exercise 5

Concepts addressed:

Creating a split document from an assembly
Managing the different shapes of the split document
Processing geometry linked to an insert

Managing constraints on lofted parting surfaces
Creating a side insert

Creating an insert on sketch

Creating the action inserts

Inserting a component

Exercise 5

TopSolid
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Starting the study

Creating the split document

e  From the Project tree, open the doorArmrest assembly document from the Exercise 05 folder.
<

e  Create a <=7 Split document from the assembly document.

Managing the different shapes

Note: If you want to perform a block split operation on an assembly of parts (for example, a molded part with
metal inserts), you need to define the molded shapes and the insert shapes.

Defining the molded shape

e The Molded Shapes command opens automatically. Select the molded shape in the graphics area. The
shrinkage will be applied to the plastic part.
o Clickon % to confirm.

Defining the shrinkage
e  Adjust the shrinkage to be applied to the molded shape to 3%.

Shape to transform:

|MOIded Shape (doorArmrest <do ~ |

Frame:

|}' |Ab50|ute Frame V| qp |

Shrinkage factor:
Automatic

(® Global

() Differential

Factor:

3%

e Clickon "4 to confirm.
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Defining the insert shape

e Select the % Insert Shapes command and select the insert shape in the graphics area. This insert will be
associated with the molded shape.

& Home -Split 5| # 2D Sketch
B9 9 %
% Maolded Shapes...

kA
. I£| '% Insert Shapes...

4

e Clickon 4 to confirm.

A molded set containing the molded shape and the associated insert is automatically created in the Entities
tree.

Entities T
T & [ e of e [ \Fe 2 %
0. Sets
..... ‘% Shapes To Split
=-4% Molded Set 1

=45 Insert Shapes
... 88 Insert Shape (doorArmrestinsert <doorArmrestinsert <109>>)
E-‘a‘i Molded Shapes

L )

|
sl

_F_Il

REEREEEE]

Eg...--':r Parting Shapes
Ej---'-!r Parting Surfaces

The colors of the molded elements match the colors defined in the Tools > Options > g Split Blocks >
@ Colors command.

4] Options O >

- General Molded set
- Colors Molded shape: Shrinkage: Insert shape: Shape to split:

[+ Display x x x x
= Printing
----- ™ Analysis
.. Rendering Parting edges

-] Assembly Candidate edges:  Selected edges:

..... T | Bom x _ x
&5 CAM Options
..... oy Drafting

..... i Family

- POM I
..... 5= Piping

-t Predefined Values

&% Search Parting shapes
Parting surfaces:  Molding area:

X I X

Molding areas mapping

[]---O_‘} Translators
E]---_,iia Walk-through Reset

o~

v ¥
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Creating the molded shape

Creating the shape

e  Switch to the @ Parting stage.

Note: A shape to split is already created in the Operations tree. It represents the union between the molded
shape (and its shrinkage) and the insert shape(s).

This shape to split will be used to calculate the parting line and create the parting shapes.

Here, the resulting shape to split is not appropriate since the current position of the insert no longer correspond
to the position of the insert on the molded shape with shrinkage.
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Geometry processing

D)
e  Switch back to the 4 Preparation stage to modify the geometries of the molded shape and the insert.
e  On the molded shape, fill the hole of the insert housing that is too large. To do this, @ remove the faces
of the hole by selecting Cap as the heal type.

Vv X s ?

Y Removing
/ ~ /

Sodee

Faces to remove:

Face(Molded Shape (doc s
| Face(Molded Shape (dod

A 4

[] Keep faces
Heal type:
Cop 4

From the Shape tab, select the Other Operations > ‘} "7 Transform command to move the insert.

L)
Select the insert as the shape to transform, then click on the =F icon and select the U~ Translation
Transform command.

e Selectthe+ By two points mode and select the first and second points as shown below.
v ¥ ?
Translation Transform

|
= |

First point:

|Centen|nsert Shape (doorArmrest v| dr |

Second point:

|CentenMo|ded Shape (doorArmn V| LE |

e % Confirm the translation transformation.
e 4 Confirm the transformation.

e  Switch back to the @ Parting stage. The shape to split is updated.

Note: Concerning the processing of the geometries of the molded shapes, every case is different. The geometric
processing that was performed on the molded shape and the insert is just one specific example.
Various types of processing are possible.
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Creating an enclosing stock

e  From the Operations tree, move the insertion cursor under the Stock operation.
=
e  From the Shape tab, create an S enclosing block from the shape to split by entering a single margin of

20mm.

Enclosing Block

Entities to enclose:

| Shape To Split (Molded Set 1

Orientation frame:

‘}' Absolute Frame v | &F |

Single margin
Single margin:
20mm

e (Click on 4 to confirm.

—
e &’ End theinsertion.
e  Edit the Stock operation and select the previously created block to define the user stock.

Creating the parting edges
Creating the candidate edges

e (Createthe % candidate edges. From the Molding axis drop-down list, select the Z axis of the molded set
frame.

° ?’ Move to the next step.
Creating the parting edges

e Create the % parting edges. Select the external path of the part.
o Clickon % to confirm.

e  Create four other % Parting edges operations for the part's openings.
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Creating the parting surfaces
Creating the automatic parting surfaces

e (Create the w automatic parting surfaces. To do this, click on the Compute surfaces button and uncheck
the Lofted with guides box.

v¥x3?

@ Automatic Parting Surfaces

Shape with shrink:

HShapeTo Split (Melded 5et 1) v| oh ‘

Meold frame:
‘ A |0pening Frame v| L ‘

Limnit:
Stock plane ~
Parting lines:

5.

Line 1

[] Automatic update
Compute surfaces...

Surfaces Pricrity:

Planar ~

Surfaces:

Planar

Extension

Extension

Extension

Lofted with guide

& ORI R A E]

Lofted without guides

e Clickon L 4 to confirm.
Editing the surfaces

e  Right-click on the surface as shown below and % edit it.
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TopSolid'Split

e  Modify the start edge as shown below.

e Click on % to confirm.

e  Repeat the procedure for the following surface.

DD

e (Create anew partlng surface using the

v

) Parting Surface

Bl s

Start edge:
”%meﬁSMHMdkdkﬂhHﬁ&v”

[[] Reverse
End edge:

Parting edges only

Meld frame:
| }||Open|ng Frame v| Lol |

Direction:

(@) Automatic

() Manual

| |

Lirnit:

Stock plane ~

Stock ¥+ Plane |

[] Draft:

o

Lateral extension:
[ At start

[ Atend

e Click on % to confirm.

N

Extension mode.

==
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Creating the lofted surfaces with guides and tangency constraints

e C(Createa @ parting surface using the " Lofted with guides mode and select "> Profile as the closing
type. Select the start edge and then the start and end profiles as shown below. Right-click on the arrows
of the start and end profiles to add a constraint to each profile.

vxXi?

@ Parting Surface

e Y

o Guides

Start edge:

”Shape To Split (Molded Set 1:Edgef ||

[] Reverse

End edge:

Parting edges only

Start profile:

‘ | shape 5iEdge(s1) | & ‘

End profile:
‘}l (Shape &:Edge(30) e ‘

Closing:

Constraint: Tangent
=IO Magnitude: 1 Constraint: Tangent
Closing Profile: o Shape 5:FaC€(87) _ﬂMa nitude: 1

[Sketch 1:Profile(14) ] @ ‘ >z Shape 8:Face(32)

Click on 4 to confirm.

e Right-click on the previously created surface and edit the sketch.
e  Modify the tangency values to 40mm.

e  Confirm the sketch.
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e  Repeat the previous operation on the following surface.

e  Click on % to confirm.

Constraint: Tangent

Magnitude: 1

> Shape 8:Face(32)

Constraint: Tangent
Magnitude: 1
- 4 Shape 4:Face(53)

Creating the lofted surfaces without guides and tangency constraints

TopSolid'Split

e  Edit the surface as shown below, then right-click on the arrows of the start and end profiles and add a

constraint.

v X ?

Parting Surface (Shape 7)

R

Start profile:

‘| Shape :Edge(102)

v|-a-|

End profile:

| 7 [shape 4Edge(a)

v|-5-|

Closing:
S~ oRe

Clesing Profile:

“Sketch 3:Profile(14)

v|nan|

e Click on % to confirm.

64

[Constraint. __Tangent |

Magnitude: 1

> Shape 4:Face(51)

Constraint: Tangent

Magnitude:

1

> Shape 3:Face(112)
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Surface continuity check
Creating the parting shells

e (Create the % parting shells. Red edges indicate that errors were found, which is normal since the shut
off surfaces have not yet been created.

e Clickon % to confirm.
Continuity analysis

e  From the Operations tree, QQ hide the top parting shell.
e  From the Analysis tab, select the ’VA Analyze Continuity command and select the h Tangency mode.

Note: Analyzing the continuity in Tangency mode allows you to check the tangency continuity of the different
parting surfaces that you have just created.

e Select edges or the lofted surfaces of the bottom parting shell.

The tangency deviations are represented by arrows. Here, the surfaces are continuous in tangency.

Maximal deviation: 0°

Deviation

Precision:

O |

Minimal deviation: 0°

e Click on ” to confirm.
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Note: On a sewn surface, you can quickly and visually determine whether its faces are continuous in tangency.
In fact, the edges between tangency continuous faces are smooth. However, it must be mentioned that the
edges of the lofted without guide surface are shown as non-smooth edges. Mathematically, they are not
continuous in tangency because they have a common vertex, even though in our case we consider them as
continuous in tangency with their neighboring surfaces.

Smooth Edges = Tangency continuity

Naon smooth edges because they have a comman vertex

Creating the shut off surfaces

e  Switch back to the ?é Parting stage.

e  (Create four ‘ Shut Off Surfaces operations using the ‘ Face mode to close all openings.
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Creating surfaces for the vertical inserts
Insert surfaces on shape

e (Click onthe % Hide/Show Stock icon at the bottom right of the graphics area to display the stock.
e Create a new sketch by selecting the stock's top face as the support plane.

e Click on the % Hide/Show Stock icon again to hide the stock.
e  Draw a rectangle with 4mm fillets as shown below.

=20=

e (Createan (B extruded shape from the previously created sketch. Select the Z- plane of the stock as the
limit.

v K &0 ?

Section:

Sketch 1 v | dr
[@fscnt  v[e

Direction:

(st o]

Limnit:

|P|ar1e V|

||StockZ- Plane v| [ ] |

[] Center
[] Draft:
1 !

[] Offset limit:

|'Imm |

[] Surface

e Clickon L4 to confirm.
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e Create ‘ insert surfaces using the @ Shape mode.
e Select the previously created extruded shape, and then select the shut off surfaces linked to that insert.

v X Eauf?

e Insert Surfaces

Shape with shrink:
“ShapeTo Split (Molded Set 1) v ”

gad

“Shape 23 W |!
Lirnit:
|Stock plane v|

‘ Steck Z+ Plane ‘

Direction:
() Automatic
(@ Manual

‘|Abso|uteZAxis v| e ‘

e Shut Off Surface
(il

Shape 18
Shape 19
| Shape 20

[ Hide

e C(Click on "4 to confirm.

The parting edges between the insert surfaces and the shape to split are automatically created. Accordingly, the
color of the molding areas is updated according to these new edges.

-
Note: Calculation and/or reaction times between each selection are longer when the 9@9 result preview is
displayed.
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Insert surfaces on sketch

e Create a new sketch by selecting the Z+ plane of the stock as the support plane.

Exercise 5

e Select the @ Standard Profile command. Select the Sectionl document. The driver values are
automatically entered.

e Delete the 25mm dimension, the 110° angle and constrain the contour as shown below.

% &0 ?

@ Standard Profile

Documents:

i% Section

Key point:

Center Point

Position:

Drivers

L:
25mm
H:
30mm
A
10°
R1:
20mm
R2:

Smm

i

—

P

e  Confirm the sketch.

TopSolid
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e Create % insert surfaces using the 0 Profiles or loops mode.
e  Select the previously created sketch.
e Clickon % to confirm.

You will notice that the color of the molding areas is updated following the creation of new parting edges.
Insert surfaces on edge

e  Onthe bottom side of the part, create an % insert surface in 0 Profiles or loops mode by selecting the
following part edge.

e  Click on % to confirm.

Creating a surface for the side insert

Note: In the case of a side insert that is located on the outside of the part, we recommend that you create the
surfaces of this insert by creating parting surfaces rather than insert surfaces.

e  Create a new sketch by selecting the X+ plane of the stock as the support plane.
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. U Imprint the resulting sketch on the shape to split. Select Specified as the imprint direction (normal to
the sketch).

Vv ¥ =) ?

Shape to modify:

| Shape To Split (Molded 5et ‘

= | 4 Ap =d
A | \
RIS

Sections:

| Sketch 3 ||

Direction

() Crthogonal
(@) Specified

o |-Sketch 3 v e ‘

[] Bidirectional

e Create anew % parting edge on these new edges.

e Clickon % to confirm.

e (Createa @ parting surface in W Extension mode from the new parting edges.

e Clickon % to confirm.
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Creating the parting shapes

Creating the parting shells

e Create the % parting shells.

Some edges of the top and bottom shells are shown in red, which means there is a problem: the parting shells
are not valid for the split operation.

e Click on  to confirm.

Editing the stock

e  Click on the % Hide/Show Stock icon in the graphics area. The defined parting surfaces do not allow you
to split the stock.

e Select the A Stock command to edit the stock defined earlier in the exercise.
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e Click on the Advanced Options icon and set an extra length of 60mm to the planes generated by the
stock.

v X ?
Stack
e

Shape:
“Shape'l W ||

Cpening frame:

‘|Absolute Frame v| L1 |

@ Advanced Options

Regenerate planes

Extra length:
| B0rmm |

Show planes

e  Click on % to confirm.

The parting surfaces are updated and will allow the stock to be split and the core cavity blocks to be created.

Note: When creating the stock, planes are generated on each face of the stock and are offset to an extra length

set by the user.
These planes are used when creating the parting surfaces and insert surfaces, when the selected limit is Stock

plane.
T ot e

Limnit:

| Stock plane v

Stock Y+ Plane

Updating the parting shells

° % Hide the stock.

e  Generate the % parting shells to update them.
o  Clickon % to confirm.
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Creating the parting shapes

e C(Createthe @ parting shapes.

v X ?
@ Parting Shapes
Cpening:
Shells Blocks ~
Shape 10 Core block
Shape 11 Cavity block
Shape 30 Insert
Shape 31 Cavity block 1
Shape 32 Cavity block 2
Shape 33 Core block 1 v

e  Rename the blocks if necessary.
o Clickon % to confirm.
Modifying the side insert

e  From the Entities tree, edit sketch 3 which generates the side insert.
e Add 2mm fillets to each top vertex of the contour.

Following this modification, the document is updated, which results in errors. The parting edges based on the
sketch imprint are no longer closed. The surface based on these edges is therefore invalid.

' TopSalid *

0 Parting Surface (Shape 26)

Guiding edges path is invalid.
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The green spheres indicate that the parting edge path is open.

e  Right-click on the open parting edge in the graphics area and select the Y Edit command.
e Add the two edges resulting from the fillet imprint operation to close the edge.

The parting surface linked to this edge is updated.
o Clickon % to confirm.

e  Recreate the % parting shells to update them.
o Clickon % to confirm.

o % Confirm the update of the k@ parting shapes that follows the update of the shells.
Adding a lifter component

Creating the lifter shape

e  Switch to the 9/} Parting stage.
e Click onthe *S Hide/Show Parting Surfaces icon.

You will notice that a hook is located inside the part.

e  From the Project tree, drag and drop the Lifter family document from the Exercise 05 > Components folder
into the graphics area.
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e  Enter the following values for the drivers.

v ¥ 0 ?
[Inclusion |

Cccurrence name:

Document:
| B Lifter w |

Code:

Drivers

JE
|10mm |
H:
|15mm |
A
e |
T

|8mm |

—

e Click on 4 to confirm.

e  For the positioning, select the bottom face of the lifter as the source geometry and the hook's horizontal
top face as the destination geometry.

e  Double-click in the green zone of the Plane on Plane 1 constraint label and enter an offset value of -Imm.

= | Plane on Plane 1
[
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e  Repeat the procedure with the two vertical planes.

[=]Plane on Plane 2
2 -1

[=| Plane on Plane 1
AL 1|

Exercise 5

e Select the g} Plane on Point command. For the source plane, create a § midplane between the two

side faces of the lifter.

e Click on % to confirm.

e  For the destination point, select the midpoint on one horizontal edge of the hook.

TopSolid

[F]Plane on Point 1

[Z]Plane on Plane 1
I
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e (Createan % insert surface using the & Shape mode.

vX§a?

@ Insert Surfaces

Shape with shrink:
| Shape To Split (Molded 5et 1) w ‘

cad

| Shape 36 v ‘
Limnit:
Stock plane W

| Stock Z+ Plane ‘

Direction:
(@) Automatic
() Manual

& |

Core cavity blocks

e  Recalculate the % parting shells.
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e (Calculate the % parting shapes.

R
e Recalculate the {yl-‘ core cavity blocks to create the new part.
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Inserts (post-split insert)

Creating the inserts

80

\ Hide the parting shapes and e show the shapes to split.

Create a new sketch by selecting the outer face of the cylindrical opening that has not yet been processed,
on the lower side, as the support plane.

o,
= B

Z
Z
7

Create a circle using the Free size mode, centered on the opening and passing through the vertex of one of
the ribs.

L)
Create an <insert using the @ Profiles or loops mode. Select the circle sketch.

[wé
Right-click in the graphics area and Q’ show the stock. Select the bottom plane of the stock as the limit
plane of the insert.

Eﬁ}‘ Hide the stock.

-

N

Always via the contextual menu, “ show the parting surfaces. Select the split face as the trimming face
of the insert.

S

" Hide the parting surfaces.

TopSolid
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v X} ag?

Shape with Shrink:
Shape To Split (Molded Set w

279

| Sketch 5:Profile(s)

Limnit:

Plane W
Cavity Block:Face(9) «|dF
Direction:

(®) Automatic

() Manual

" | -Absolute 7 Axis

@ Trimming

aces |

| Face(Shape 21:Face(8) |

e Clickon % to confirm.

e (Create a second
opening.

e Select the top face of the stock as the limit plane of the insert.
e Select the face of the previously created insert as the trimming face.

e Click on % to confirm.

Ll

e Inthe Entities tree, rename the last two shapes created.

TopSolid

El} Shapes
i B Toplnsert
... Bottom Insert

Exercise 5

< insert based on a loop on the top side of the shape to split. Select the top loop of the
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Creating processes for the inserts

° c Subtract the core and cavity blocks using the corresponding inserts.

Creating the core cavity blocks

'{*s',: .
e C(Createthe & core cavity blocks.
e Clickon % to confirm.

Shape with shrink

e  From the assembly document's Parts tree, select QQ Hide All to hide all the parts listed in the tree.

-
e  Filter the parts listed in the tree by checking the Shape with shrink function. The @9 Show All command
allows you to show the part with shrink.

Reminder: Shape with shrink = Shape to split (= Molded shape with shrinkage + Insert shape) — Insert shape.
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Core block
e  Show the core block and the insert.

e Create a graphical a cut of the block and the insert according to the YZ plane and passing through the
center of the insert.

|

) Cut by Planes

Plane:

|}l Plane2 <201> |4 |

(O Offset:

(®) Passing point:

CenterEmpreinte infé « | db

Advanced Settings

e Click on % to confirm.

The insert has been subtracted from the core block.
Modifying the insert's housing

e  Right-click on the core block and select the . Open Document command.
/1% %
° @ Remove the chamfers inside the housing by selecting the @ Faces mode and the Blend heal type.
o K tops ?

Type:
doase

Faces to remove:

| Face(Cavity BlockiFace(4| o,

[] Keep faces
Heal type:
Blend v
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e  From the Shape tab, select the : Faces Modification command and shift the bottom of the hole to Imm
downward.

Vv ¥ e ?

@ Faces Modification
-

Faces:

Face(Shape To Split {Moi o

Shift:

-Tmm

Check-in

e  From the Project tree, '8 check the Exercise 05 folder into the vault.
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Exercise 6

Concepts addressed:

- Using Design surfaces as parting surfaces
"Inserts" of inserts
- Operations on parting shapes

Exercise 6

TopSolid
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Starting the study

e  From the Project tree, open the leftArmt part document from the Exercise 06 folder.

Defining the shrinkage

e  From the part document, create a @ Split document using a blank template.
e  Apply a global shrinkage of 1.5%.

Vi ?
T

Shape to transform:

Molded Shape (leftArm <157>) |

Frame:

Injection £150> (Publishi ~ | 45
Shrinkage factor:

Automatic
i® Global
() Differential

Factor:
1,5%

e Click on % to confirm.

Creating the stock

e  Edit the stock, and then modify the origin frame by creating a l( frame by point and 2 directions.
¢.
e  For the frame origin, create an +  offset point of 20mm along X.

e Createa < center of mass point as the reference point of the offset point.

v X ?

Stock
Pee

X length:
|?_Dﬂrr1m |

Y length:
|?_5'Drr1m |

£ length:
|1E'Drr1m |

Opening frame:

Frame 1 v | dh

| Automatic... ‘

e Click on % to confirm.
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Creating the parting line
Creating the candidate edges

e (Createthe % candidate edges. From the Molding axis drop-down list, select the Z axis of the molded set
frame.

° ?’ Move to the next step.
Creating the parting edges

e Createthe ‘ parting edges. Select the external path of the
part.

e Click on ¢ to confirm.

e Create other three % Parting edges operations for the
part's circular openings.
o Clickon % to confirm.

e (Create a last ‘ Parting Edges operation to define the
future side insert.

e Clickon 4 to confirm.

Creating the shut off surfaces

e (Create the three % shut off surfaces at once using the % Shape mode.
o Clickon % to confirm.

Creating the parting surfaces

e Create two % parting surfaces in L Extension mode using an automatic extension direction to the
stock plane.

e  Click on % to confirm.

e (Createa Eﬁ/ parting surface in \’ Planar mode.

e Clickon % to confirm.

e

2

I

Shape 5:Edge(102)

For the rest of the exercise, it will be difficult to finish the parting line by creating Extension or Planar parting
surfaces. The surface on which the parting edge path is based is very large and consists of only one surface.
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Face copy

e  From the Surface tab, select the D’ Faces command and create a face copy using the %—‘ Face with
trimming path mode.

M
w-'-i;&

Face to copy:

“ShapeTo Split (Molded Se' v ”

Minimum
[] Periedic

@' Trimming Path

Start edge:
“ShapeTo Split (Molded S v ”

7

Complementary path

Reverse
Start extension mode:

| Complementary path v |

Start direction:

|2 +]
End edge:

| shape To Spit (Molded Se v |

[Complementary path |

End extension mode:

| Complementary path W |
End directicn:
B +

Reverse trimming

Warning: Make sure to extend the face on each side using the yellow spheres so that it goes beyond the limits
of the stock.

e Clickon % to confirm.

° @ Trim the resulting face by creating an offset plane of -30mm from the XY reference plane.

Offset Plane

Reference plane:
||AbsoluteXYPIane v| LEl |
Offset distance:
|-30rnm |

m

e  Click on % to confirm.
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e Select the (ﬁ Extruded command. In the Section field, enable the face selection by clicking on the ‘
icon, and then click on the boundary edge of the surface. Adjust the extrusion direction along Y and enter
a length of 200mm.

VKt ?

Section:

| ape 4. £l W
Shape &:Edge(16) &

Direction:

|}| Frame (Molded Set 1):¥ Axis v | 4k ‘

Lirnit:
Length ¥
100mm

[] Center
Draft:

Cffset limit:

Tmm

Surface

e  Click on % to confirm.

Note: TopSolid'Split provides dedicated tools to help you create core cavity blocks. As a reminder, a % Split

document is similar to a Part document. Accordingly, you will find all the volume, surface and part design
tools, etc.

Addition as parting surfaces

b
e Hold down the Ctrl key and select the last two surfaces created. Right-click and select the % Add in
Parting Surface Set command.

The parting surface set is available in the Entities tree's Sets folder.

-

e (Click on the % icon to hide or show all parting surfaces.

Creating a parting surface for the side insert

e Create a & parting surface in L Extension mode to create the surface of the side insert. Select an
automatic extension direction to the stock plane.

e Clickon L4 to confirm.
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Creating the insert surfaces

e Create two % insert surfaces on the edge loops as shown below.
vXiag?

e Insert Surfaces

Shape with shrink:

‘ Shape To Split (Molded Set 1) w |

qad

Shape To Split (Molded Set 1):Edg
| Shape To Split (Molded Set 1):Edd

Limnit:

Stock plane v

‘ Stock X- Plane |

Direction:
(@) Automatic

() Manual

7 |

e C(Click on 4 to confirm.

In this way, two side insert surfaces will be created in the main side insert.
Creating the parting shapes
Parting shells

e (Create the % parting shells.
o Clickon % to confirm.

Creating the parting shapes

e C(Createthe % parting shapes.
e (lickon Q? to confirm.

Modifying the geometry of the parting shapes

TopSolid'Split

e Createa20mm @ fillet on the core block's closing edge and another 30mm fillet on the opposite edge on

the cavity block.

Core block

90

Cavity block
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Creating the core cavity blocks

O :
e (Createthe & core cavity blocks.

e Clickon % to confirm.

Check-in

e  From the Project tree, ¥ check the Exercise 06 folder into the vault.

TopSolid 91



Exercise 7

Exercise 7

Concepts addressed:

92

Replacing a part

Repairing existing operations
Editing the parting line

PDM management

TopSolid'Split
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Starting the study

e  From the 03-Core cavity blocks sub-folder of the Exercise 01 folder, validate the life cycle of the
remoteCover assembly document. To do this, right-click on the document and select the Life Cycle (A-

Design) > '/ Validate command.

The part document and split document are also validated since they are the references of the assembly
document.

e Inthe 01-Customer part sub-folder, create a new sub-folder named New part.

e  From the Exercise 07 folder, ég copy the remoteCoverNewPart part document and = paste it into the
New part folder.
e Open the remoteCover and remoteCoverNewPart documents.

Replacing the part
A | )
e In the remoteCover document, WL7 replace the geometry of the part with the geometry of the
remoteCoverNewPart part.
The shape to replace is automatically selected.
o |nthe New shape field, select the remoteCoverNewPart document from the drop-down list.

» X ?

Shape to replace

Shape:

ﬂ

New shape

vl

Shape:

fome ]

Transformation:

Note: If the new shape used to replace a shape geometry comes from another document, this document must
be open before launching the command.

The screen is automatically shared between the two documents and the camera of the two documents is
synchronized.

e  Leave the Transform field empty.
° [*’ Move to the next step.
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The dialog box displays the comparison result between the two shapes. Up to this point, the command is

-
identical to the - Compare command.

@ Comparison result

=l-+FL Similar faces A

[+ Identic loops
D___,.: Different loops

; [:I"f"': Different geometry
Elf_; Different faces on new shape
Face

Face

Face

Face

Face

Face

Face

Face

by g 8y Sy A Ay g Ay dy

Eare

Transformation:

° ‘ﬁ’” Move to the next step.

The replacement operation starts from this point.
o % Confirm the replacement.

° M Save the remoteCover document.

When saving the document, a B major revision is automatically created for the remoteCover document.

& | Exercise D1
- @ + 01-Customer part
: ---# . Mew part
v P remoteCover
E| Revisions
-4k Uiy B (Design)
- & %y A (Validated)

e  Open the split document.

A warning message appears indicating that the part referenced by the split document has been modified and
changed version.

+/ TopSolid *

Document has some references not redirected to last major revisions, Do you want to
@  update?

Yes MNo

e  Click on Yes to redirect the split document to the new part version.
e %7 Confirm the redirection of all references.

Redirect All References... 4 X
v ?

Decument

------ & remoteCover (0)
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Exercise 7

Note: Redirecting the split document to the new version of the part will update the split document. Warning

messages appear indicating that errors occurred during update.

+/ TopSolid

/1, Candidate Parting Edges 1
el
Some edges have been removed.

/' TopSaolid

0 Parting Surface (Shape 1)

Guiding edges path is invalid,

Repairing the parting line

A

e  Switch back to the Parting stage.

e  Right-click in the graphics area to % display the parting edges if they are hidden.

Parting edges

The parting edge path is not closed anymore.

e  From the Operations tree, move the insertion cursor under the

% Parting Edges operation.

e (Create a new % Candidate Edges operation using the Z axis of

the molded set frame.

e  Move the insertion cursor up to the Parting Edges operation.
e  Edit the edge path and add the missing edges following the part

modification.

TopSolid
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e  Edit the invalid parting surface by clicking on the 0 icon in the document's tab. Modify the end edge of
the guiding edge path and modify the end extension direction of the path to create the following parting
surface.

v X ?

Parting Surface (Shape 1)

SRy

Start edge!
“Shape To Split (Molded Set 1):Edge ~ |

Reverse
End edge:
[ Shape To Split (Molded Set T):Edge « |

Parting edges only

Mold frame:

‘|Opening Frame v| L ‘

Start extension mode:
| Part v |

Start direction:
E |

End extension mode:

|Part v|

End directicn:
E |

Limit:

|Stock plane v|

‘ Stock X- Plane ‘

e Inthe same way, create the symmetrical @ parting surface.
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Parting surfaces

e Create four ﬁ/ parting surfaces in N Extension mode on the side faces of the two tabs. Indicate the
extension direction by selecting the edge at the end of the tab. The surface is limited by a plane (the part's
top face).

v i?

Parting Surface

B & &

Start edge:
Shape To Split (Molded Set 1):Edge +

Reverse
End edge:
Shape To Split (Molded 5et 1):Edge w

Parting edges only

Mold frame:
A Opening Frame w|db

Direction:
() Automatic
(@) Manual
A Shape To Split (Molded Set v | 4k
Limit:

Plane v

Shape To Split (Molded Set 1:F v | dp

Lateral extensicn:
[ At start

[JAtend

e  Repeat the operation on the other side of the tab and then on the second tab.

e Create two &/ parting surfaces in > Lofted without guide mode for the end of the tabs.

@ Parting Surface
el

Start profile:
A Shape &:Edge(40) v| &

End profile:
A |Shape &:Edge(40) w | gh

Closing:
% B

Closing Profile:
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—
e %’ End the insertion.

e  Create a new 2D sketch based on one plane of the side flat surfaces.

e (Create a contour in D Passing mode based on the parting surface's edges.

TopSolid'Split

@

e  Confirm the sketch.

e C(Createa < flat surface from the previously created sketch.

e  Right-click on the flat surface and select the ? Add in Parting Surface Set command.

Creating the parting shapes

Updating the parting shells

e Create the % parting shells to update them.

e C(Clickon "4 to confirm.

Updating the parting shapes

o % Confirm the % parting shapes to update them.

° B Save the remoteCover split document.

When saving the document, a B major revision is automatically created for the remoteCover document.

EIE

02-5plit

BT iccove

EI--_ Revisions
-k ‘iz B (Design)
- & Yy A (Validated)
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Updating the assembly

e  Open the RemoteCover assembly document.

A warning message appears indicating that the part referenced by the split document has been modified and
changed version.

v TopSelid X

Document has some references not redirected to last major revisions, Do you want to
@  update?

e Click on Yes to confirm the update.

The assembly document and the part documents take a major revision.

E- & 03-Core cavity blocks
v §
=--_ " Revisions
-4k ‘i B (Design)
E- &ty A (Validated)
P remoteCover.Core block
El Revisions
w4k ‘iz B (Design)
E- & % A (Validated)
I remoteCover, Cavity block
El Revisions
-4 ‘iz B (Design)
- @ A (Validated)
P remoteCover. Shape With Shrink (Molded Set 1)
El Revisions
-4 ‘iz B (Design)
@ & %y A (Validated)

Check-in

[ |

e  From the Project tree, ¥ check the Exercise 01 folder into the vault.
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Exercise 8

Concepts addressed:

- Creating parting edges in planar mode
- Using the Split commands to obtain the main parting shapes
- Modifying the parting shapes manually to have the right number of core cavity blocks
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Starting the study
e  From the Exercise 08 folder, open the Box part document.
Defining the shrinkage

e (Create a new g Split document from the part.
e  Apply a shrinkage factor of 1.02.

Vi ?
[Shrinkage 1 ]

Shape to transform:

Molded Shape (Box <157>) v|

Frame:
|njection<159:- (Publishi ~ | &

Shrinkage factor

Automatic
(@ Global
() Differential

Factor:
1,02

e Clickon % to confirm.
Defining the stock

e Createan @ enclosing block around the part and enter a single margin of 50mm.
v K 0 ?

@ Enclosing Block

Entities to enclose:

Shape To Split (Molded Set 1

Crrientation frame:

|Abso|ute Frame v| qn

Single margin

Single margin:
|51]Imm |

e C(lickon L4 to confirm.
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e  From the Operations tree, move the Enclosing Block operation under the Stock operation.

-=mp Parting Stage

@-% Stock

'Ij:j Enclosing Block (Shape 1)
- Shape To Split 1

e  Select the A Stock command and select the previously created block as the user stock.
v X ?
Stock
o8

Shape:
”Shape'l V| L1 ‘

Opening frame:

||Frame(MoIded Set 1) v| o |

e Clickon % to confirm.
Creating the parting line
Parting edges

e  Select the ‘ Parting Edges command.

e Click on the ¥ icon and select the @ Edges from Plane command.

X 37

Parting Edges
Shape to modify:
“ShapeTo Split (Molded Set 1) V| Li |
Edges:
]
Selection
@ Boundary edges between vertices..,
< Edges from Parting Surfaces...
[] Candidate edges only | ~ Edges from Plane...
Closed candidates edges only 53+ Edges Repetition...
Planar candidates edges only . Holeedges...
3 Imprint...
i& Path between two edges...
< Paths around faces...
e  Select the circular edge as shown below as the plane to be used. Check the Internal box to select only the
hole edges.
v % ?

& Edges from Plane

Plane:

([shape To Split (Molder | & ‘

[ External
[ Internal
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e Clickon L4 to confirm.

e Create three more parting edge operations for the top edge, the bottom edge and the side openings.

Shut off surfaces

e (Create the % shut off surfaces for the side openings using the % Face mode. Select the bottom edge
and the top edge of the part as the edges to ignore.

vXE3a?

2

Shape:

HShapeTo Split (Molded Set 1) v| & ‘

Edges to ignore:

Shape To Split (Molded Set 1):Edge(3]
| Shape To Split (Molded Set 1):Edge(9]

e Clickon 4 to confirm.

Parting surfaces

e Create the top and bottom @ parting surfaces using the \’> Planar mode.
vXE3?

) Parting Surface

SRy s

Start edge:

“Shape To Split (Molded Set 1):Edge(t ~ ||

[] Reverse
End edge:

|| Shape To Split (Molded Set 1):Edge(l ~ ||

Parting edges only

e Clickon L4 to confirm.
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Creating the main core cavity blocks

e  Select the % Parting Shells command.

e  Calculate the % parting shapes.

P R
v X ?
@ Parting Shapes

Opening:

Shells Blocks
Shape 88 Cavity block
Shape 29 Core block
Shape 90 Core block 1

Cutting the center block

e  Right-click on the core and cavity blocks and &4 hide them.
e  Create the following sketch on the Z+ plane of the stock.
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Select the mTrim by Profile command and trim the center block using the previously created sketch.
Check the Keep trimmed side box in the advanced options.

v ¥ tea) ?
Shape to modify:
|ch'rtyb|ock1 v|

ST

Section:
Sketch 1 w | gh

[] Extend profiles
Reverse

Direction:

||Slvcetch 1 v @ |

®

Hide tools

Advanced Options

Keep trimmed side
Fill representations

e  C(Create a new sketch on the Z+ plane of the stock.
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e  Select the m Trim by Profile command again and trim the remaining section of the center block. Check
the Keep trimmed side box.

v ¥ 0 ?

@ Trim by Profile

Shape to modify:
Cavity block 1 v|

5eeT

Section:

Sketch 2 W | o

[] Extend profiles
[] Reverse

Direction:

Sketch 2 v

®

Advanced Options

Hide tools

Keep tnmmed side
Fill representations

e |n order to split the remaining shape in two, a trim this shape using the injection frame's XZ plane and
keep the trimmed side.

Vv ¥ ) ?

Shape to modify:
Cavity block 1 v

so0on

Trimming plane:

Frame (Molded Set w | dh

Reverse

@

Advanced Options

[] Hide tools

Keep trimmed side
Fill representations
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Creating the core cavity blocks

Exercise 8

e  From the Entities tree, rename the new shapes resulting from the trim operations and drag and drop them

into the Action Inserts set.

o
-

5«' ! Action Inserts

5% Centerblock 4
5% Centerblock 3
3% Centerblock 2
2% Center block 1

Inserts

Core Cavity Blocks

% Core block

A% Molded Set 1

W

: :r Parting Surfaces

& Centerblock 3
& Centerblock 2
& Centerblock 1
& Core block

& Cavity block

¥
e Select the {!ﬁ Core Cavity Blocks command.

-39 Cavity block
4%} Parting Shells

Wl Shapes To Split

v X ?
@ Core Cavity Blocks
Derived parts:
Shapes Parts Type
w Box.Cavity block Core cavity block L
Core block Box.Core block Core cavity block W
Center block 1 Box.Center block 1 Action insert W
Center Block 2 Box.Center Block 2 Action insert W
Center block 3 Box.Center block 3 Action insert W
Center Block 4 Box.Center Block 4 Action insert W

TopSolid
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Check-in

-
e  From the Project tree, "2 check the Exercise 08 folder into the vault.
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Exercise 9

Concepts addressed:

- Positioning two parts in a split document
- Declaring two molded sets
- Editing the core cavity blocks

TopSolid

Exercise 9
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Starting the study

Creating the split document

e (Createa @ Split document in the Exercise 09 folder.
e Rename this document Front + rear cover.

e Create afirst % offset frame by 40mm from the absolute frame along X+.

e Create asecond Q< offset frame by 40mm from the absolute frame along X-.

Drag and drop the Front cover part document to the split document's graphics area.
Repeat the operation for the Rear cover part document.

e  Confirm the positioning.
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Positioning parts

o I*4 kdit the positioning of the Front cover part.
T

e  Since the first part is fixed, right-click on it and select the ™" Unfix command.

p
e Createa < frame on frame constraint between the part's published frame and the X+ offset frame.

H

e

Al -
_-40 g /

[<%]Frame on Frame 1

e  Confirm the positioning.

e Inthe same way, position the second part on the second frame.

e  Confirm the positioning.
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Defining the molded shapes, the stock and the shrinkage

Molded shapes

e  Create a first % molded shape from the Front cover part, and then 4 confirm.

e (Create asecond % molded shape from the Rear cover part, and then v confirm.

Stock

e  Switch to the \!Z Parting stage.

<
° Create an ‘E

v K 0 ?

Entities to enclose:

@ Enclosing Block

Meolded Shape (Frent cover <
| Molded Shape (Rear cover <]

Orientation frame:

‘ Absolute Frame | &b

Single margin

Single margin:

|40mm

g enclosing block that includes the two parts and enter a single margin of 40mm.

TopSolid'Split

e  From the Operations tree, move the Enclosing Block operation under the Stock operation, and then create

a G user stock.

Shrinkage

%
e Applya 's shrinkage of 1.02 to the Front cover part.

e  Repeat the operation for the Rear cover part by applying the same shrinkage.

e C(Create afirst % shape to split by selecting the first part.
e  Repeat the operation for the second part.

N

The Operations tree should look like this in the parting stage .

== Parting Stage

- Stock

- Shape To Split 2

- Shape To Split 1

' Enclosing Block (Shape 1)
i

D)
The Operations tree should look like this in the preparation stage 4

112

ey WO oy OO OO o OO s OO

--a=p Preparation Stage

o Shrinkage 2 (1,02)

738 Shrinkage 1(1,02)

]"'{& Molded Shapes (Melded Shapes)
73 Molded Shapes (Molded Shapes)
]--11; Positioning 2 (Rear cover <176>)
]--{J: Positioning 1 (Front cover <163=)
----- 1.k Offset Frame (Frame 2)

..... 1.1 Offset Frame (Frame 1)
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Creating the parting line
Parting edges

e (Create the % parting edges on the two parts, making sure that you select the right part to be modified

each time.
-Eq

e Create the foIIowmg partmg surfaces using the - Planar mode.

P

e Create the following @ parting surfaces using the L Extension mode and extend the two blue surfaces
to the stock plane and the two green surfaces to a 20mm length.

Parting surfaces
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Create the following sketch on the absolute XY plane.

TopSolid'Split

)
e  Right-click on the two green surfaces and select the Q Delete from Parting Surface Set command.

7

Sketch...

Selection

Attributes...

Sets...

Delete

Hide

Show Only

Delete from Parting Surfaces Set

XTI Y TET

Others

Hide Shapes To Split
Show Stock
Hide Parting Surfaces

A
° " Sew these two surfaces with the central surface_.

114

)
Right-click on the resulting surface and select the % Add in Parting Surface Set command.
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e  Create the two missing surfaces using the 0 Fill Hole command.

e (Create the s shut off surfaces.

TopSolid

v ¥ =i ?

Hole edges:

||Bour1dary edges(Shap V| Ch |

Profile:

Method:
Fill ~

Continuity:

& &

Special edges:

| Edge Continuity

[J Minimal division

Exercise 9
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Creating the core cavity blocks

e Create the % parting shells.

e Create the % parting shapes.

° 6@ Hide the core block.

e  From the Shape tab, select the g Faces Modification command and shift the following two faces by
0.5mm along Y-.

W ¥ e ?

@ Faces Maodification

el | e

v W

Faces:

Face(Cavity block:Face(1624 ok
| Face(Cavity block:Face(1620]

Shift:

-0,5mm
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N \
\&\ N\

ViR

At .
e  Create the core cavity blocks.

v X ?
L]
@ Core Cavity Blocks
Derived parts:
Shapes Parts Type

Front + rear cover,Cavity block Core cavity block ~
Core block Front + rear cover.Core block Core cavity block ~
" Shape With Shrink (Mclded 5et 1) | Front + rear cover.5hape With Sh... | Shape with shrink ~
Shape With Shrink (Molded Set 2) | Front + rear cover.Shape With Sh... | Shape with shrink ~

Check-in

e  From the Project tree, '8 check the Exercise 09 folder into the vault.
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Exercise 10

Concepts addressed:

- Creating parting edges using repetition

Starting the study

e  From the Exercise 10 folder, open the Juicer part document.

e Right-click on the absolute frame and select the Others > WS Publish Frame command from the Selection
section.

e Createa g Split document from the part document.

Defining the shrinkage

e  Apply a shrinkage factor of 1.005.
Defining the stock

e  Creating a cylindrical A stock as shown below.

v X ?

vE®

Diameter:
ﬁ 50mm l

Length:
i 100mm l

Opening frame:
Frame (Molded Set 1) VI ) l

[ Automatic... ]
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Creating the parting line

Parting edges

Exercise 10

e  Right-click in the graphics area and select the ‘ Parting Edges command. Make sure that you pin the

dialog box.
e Create the parting edges for the first opening.

e Create the parting edges using edge repetition.

X & ?
-
Parting Edges
Shape to modify:
“Shape To Split (Molded Set 1) v| L1 |
Edges:
3
Selection
:ﬁ Boundary edges between vertices...
< Edgesfrom Parting Surfaces...
[ Candidate edges only Edges from Plane...

Closed candidates edges only
Planar candidates edges only

Edges Repetition...

Hole edges...
Imprint...
Path between two edges...

Paths around faces...

e  Draw a selection box that includes the edges of the first opening.

* adf ?

@ Edges Repetition

Edges to repeat:
Edge(Shape To Split (Molded Set 1):Edge(5¢ A
Edge(Shape To Split (Molded Set 1):Edge(57
Edge(Shape To Split (Molded Set 1):Edge(57
Edge(Shape To Split (Molded Set 1):Edge(5¢
Edge(Shape To Split (Molded Set 1):Edge(5¢
Edge(Shape To Split (Molded Set 1):Edge(5¢
Edge(Shape To Split (Molded Set 1):Edge(4(

| Edge(Shape To Split (Molded Set 1):Edge(4( ,,

Pattern:
| <] %
[ Imprint

TopSolid
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Exercise 10 TopSolid'Split

e Click on the i icon from the Pattern field and create a circular pattern around the Z axis with a total count
of 35.

v X ?

e Circular Pattern

Type:

Revolution

Axis:
[Z[posenczai e

(@ Total angle
(O Spacing angle
1360°

&

\\ \ ”‘ﬁfﬂ

—

i
i
I
I
I

Total count:
(35

[] Alternated numbering

Start point:
“Center‘.Shape To Split (M v’ L] I

_\(.’ ==

Start frame:

2] “#]

. ¥ Confirm the pattern, and then the repetition.

e  Create the parting edge at the bottom of the fillet.
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Parting surfaces

e Create the % shut off surfaces.

v X Eag?

*Re

Face:

R Ly,
o, AP

“Shape To Split (Molded Set 1):Face( v ||

Edges to ignore:

[] Internal parting edges
Use complete parting edges

[] Invert extension side

@ Advanced Options

Fitting
Tolerance:
0,01mm
Smoothing
B0 &
Angular tolerance:
(1°

@ Punctual influence

(O Distributed influence
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Exercise 10

e  Create the following !\E‘/ parting surface using the \" Planar mode.

Creating the core cavity blocks

e C(Createthe % parting shells.

122

.

vx3?
@ Parting Surface

e

Start edge:

lehape To Split (Molded Set 1):Edge(; v H

[[] Reverse
End edge:
| “

Parting edges only

Mold frame:

‘ A IOpening Frame VI LHl ‘

Start extension mode:

| Part v
Start direction:

|

End extension mode:
Part v
End direction: ‘
e |

Limit:

Stock plane v

| Stock X- Plane ‘

TopSolid'Split
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e (Createthe (@ parting shapes.

O .
e Createthe & core cavity blocks.

' %)

///MEI LL A

Check-in

=
e From the Project tree, © check the Exercise 10 folder into the vault.
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Exercise 11

Concepts addressed:

- Creating parting surfaces based on vector profiles

Starting the study

e  From the Exercise 11 folder, open the Glasses part document.

e (Createa g Split document from the part document.

Defining the shrinkage
e Apply a shrinkage factor of 1.006.

Creating a user shape

e  From the Operations tree, move the insertion cursor under the Stock operation.

E-® Stock
L= Parting Stage
-9 Shape To Split 1

e  Create a 2D sketch on the absolute XY support plane.
e  Draw a 140x70mm rectangle and set the following constraints.

i

:1%0:
i
i
T
i
i
|
i
i
i
i
i
i
i
i
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e Createan (’ extruded shape of 20mm with a second side of 40mm.

Defining a user stock

e  Right-click in the graphics area and select the %’ End inserting command.

e Select the - Stock command again. Select the " User option and select the previously created block.
o Clickon % to confirm.
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Creating the parting line
Creating the candidate edges

e  Select the % Candidate Edges command. From the Molding axis drop-down list, select the Z axis of the
molded set frame.

Creating the parting edges

e  Select the ‘ Parting Edges command.

e Click on the iF special inputs and perform an 5‘ imprint operation using the Isoclines and Faces modes.
Select the faces to consider as shown below, then add the faces on the opposite side.

v ¥ ?

Shape to modify:
‘ Shape To 5plit (Molded Set 1) |

Direction:

‘|Frame[MoIded Set1)i v | & |
Angle:

o |

(®) Faces to consider

() Faces to ignore

Shape To Split (Molded 5et 1): A
Shape To Split (Molded Set 1):
Shape To Split (Molded Set 1):
Shape To Split (Molded Set 1):
Shape To Split (Molded Set 1):
Shape To Split (Molded Set 1):
Shape To Split (Molded Set 1):

| Shape To Split (Molded Set 1)1,

@ Advanced Options

Hidden faces:
| Shape ~ |

Connection of imprinted edges:

MNone ~

Imprint precisicn:

| Accurate ~ |

Select as parting lines

o % Confirm the imprint operation.

e  Select the additional parting edges and click on Q? to confirm.
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Creating the vector profiles

Exercise 11

This operation allows you to create vector profiles from a selected point on a parting line edge path. The profile

can either be orthogonal to the molding axis or tangential to the faces connected to that point.

e Createa ? vector profile as shown below.

vxi?

@ Vector Profile

Vertex:
|| Shape To Split (Molded ~ ||

First edge:
| Shape To Split (Molded v”

Second edge:
|Shape To Split (Molded v”

@ Vector

Mode
(O Superior face

(® Molding axis
() Inferior face
() Direction

Length:

40mm

Meolding axis:
‘ A |Opening Frarm v| ah ‘

First rotation angle:
20°

Second rotation angle:

[ Reverse the first
[] Reverse the second&

e Clickon % to confirm.

TopSolid
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Exercise 11 TopSolid'Split

e  Repeat the operation to create the following vector profiles.

Vector profile (2) Vector profile (3)

Vector profile (4) Vector profile (5)

' 40
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Vector profile (6) Vector profile (7)

Vector profile (8)
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Exercise 11 TopSolid'Split
Creating the parting surfaces

The parting surfaces can be created based on the previously created vector profiles.

e Createa % parting surface using the " Lofted with guides mode and select Profile as the closing type.

vxXE?

Parting Surface
AR~

Start edge:
'Shape To Split (Molded Set T):Edge( |

[] Reverse
End edge:

Parting edges only

Start profile:

A |Profile @ v| &
End profile:

A |profite 12 v| @
Closing:

. " »
A
Clesing Profile:
[Sketch 2Profile(14) v| @

e Clickon 4 to confirm.
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Exercise 11

e (Create a new @ parting surface using the " Lofted with guides mode and select Profile as the closing

type. In the advanced options, check the Smoothing box and select the Global mode because the parting
line is considered discontinuous.

vk ?

) Parting Surface

v

@ Guides

Start edge:

'Shape To Split (Molded Set 1):Edge(: - |

Reverse
End edge:

Shape To Split (Molded Set 1):Edgel -~

Parting edges only

Start profile:

A |profile 9 v| @

End profile:
A | Profile 6 v| @

Closing:
Closing Profile:

[Sketch 3Profile(14) v| @

@ Advanced Options

Fitting
Tolerance:

0,07mm

Smoothing
O B e

Mumber of interpolation points:
100

e Clickon % to confirm.
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e  Repeat the previous operations to obtain the following surfaces.

e  Create the missing parting surfaces using either the Extension or Planar mode.

=
° F"‘b Repeat the surfaces by symmetry using the absolute YZ plane.
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Creating the shut off surfaces

e (Createthe % shut off surfaces. To do this, select the % Shape mode and select the part in the graphics
area. In the Edges to ignore field, select a bottom edge of the part so that no shut off surface is created
here.

v X} a?

e

Shape:
“ShapeTa Split (Moldec ~ | & ‘

Edges to ignore:

Creating the parting shapes

Parting shells

e Create the % parting shells.

Creating the parting shapes

e (Create the % parting shapes.
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Exercise 11 TopSolid'Split
Creating the core cavity blocks

A5 ,
e C(Createthe k& core cavity blocks.

Check-in

e  From the Project tree, @ check the Exercise 11 folder into the vault.
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Exercise 12: Template Linked to Core Cavity Blocks and Inserts

Introduction

When the core cavity blocks are generated, the template selected to create the part documents is blank.

Accordingly, the core cavity blocks and the inserts have no material and the physical properties are not
calculated, meaning that you need to manually apply the material and calculate the properties on each part.

You can avoid this by creating a part template that is specific to the core cavity blocks and the inserts.
Creating the template with calculated stock dimensions

»
o Fromthe ¥ TopSolid menu, select the File > Document Templates > N Open My Templates command.

|
e Createa ﬂ Part document using the Steel Part template and rename it Block Template.
e From the Entities tree’s Parameters folder, double-click on the Stock Type parameter.

5.%F Parameters
23.':‘3’ Preduction Type = Unclassified
- 2:.?;\" Stock Type = Unclassified

e Select the Rectangular value from the drop-down list.

v X ?

@ Stock Type

Type:
o Tod ]

Mame;

|St|:|clcT:,rpe ‘

Value:

| Rectangular v‘

e Clickon ™" to confirm.

e From the Entities tree, open the Parameters > Stock Calculation > Rectangular folders, double-click on the
BoxXSizeMargin, BoxYSizeMargin and BoxZSizeMargin parameters and enter margin values for the stock
calculation.

e Clickon ™ to confirm.
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Exercise 12: Template Linked to Core Cavity Blocks and Inserts
TopSolid'Split

136

From the Construction tab, select the Parameters > Associate template to > Core Cavity Block command.

> : — e =
o Construction |w| " Tools =

Parameters
Points

Axes

Planes
Frames
Directicns
Profiles
Sections
Block Envelopes
Picture...
Transforms
Deformations
Patterns

Serialization...

Check the Associate the template to: Core Cavity Block box and ™ " confirm.

W K

f%jg\bﬂoﬁalo

| j &
i IR e @

==

=F

Real Pararneter..,
Angle Parameter..,

Distance Parameter...

Distance in Direction Parameter...

Length Pararneter..,
Threading Pitch Parameter...
Surface Area Parameter...
Vielume Parameter...

Table Parameter...

Switch Parameter...

Optimize Pararmeter..,

Boolean Parameter...

Integer Pararneter...
Switch Integer Parameter..,

Enumeration Parameter...

Switch Enumeration Parameter...

User Enumeration Parameter..,
Text Parameter..,

Multiline Text Parameter...
Table Text Parameter...

Switch Text Parameter...

Other Parameters

Relays

User Property...

Associate ternplate to
Excel Link...
Type for BOM...

E Custom

2

Core Cavity Block

Associate the template to: Core Cavity Block

Angle Pin
Baffle

Base Shape
Core Cavity Block
Derivation
Electrode
Extruded Bar
Insert

Mirror
Partial Part
Pin

Plate

Slide

Repeat the operation by selecting the Associate the template to > Insert command.
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Note: When creating the core cavity blocks, TopSolid will propose to select a document template.

Exercise 12: Template Linked to Core Cavity Blocks and Inserts

Mew Document (Part) - Core Cavity Block Oa >

Temnplate:

Project Templates

: My Templates
| M Block Template (Insert, Core Cavity Block)
Modeles standards Usinage - France

Modeles Standards Usinage Fil - France
Modeles standards - France

Modéles standards Métal - France
Modéles standards Outillage - France

v ¥ ?

You can also store the core cavity block template in the Templates > Defaults folder of the project template. In
this way, the template will be selected by default and TopSolid will not ask again.

TopSolid

& ' Project Template

-atw References

.

& [ Templates
= @ Defaults

G- & ! Block Template (Insert, Core Cavity Block]

& y, Favorites
& T Recycle bin
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Annex

Introduction

Throughout the creation of the molded parts, the TopSolid'Split module will go through three specific stages.
These stages follow a design order. Dedicated operations are performed at each stage. You may sometimes
need to go back to an earlier stage. In this case, you only have to select the desired stage from the drop-down

menu as shown below.
AN R RSP Sl Juicer - TopSolid

ﬁHume = split - _jED Annotation Stage

b’r . % ] tﬁa = "  Analysis Stage
| ! e Modeling Stage
; % Parting Stage
] Lﬁj ' '-'A‘:l
CeJ I:w? €3 & i “¥  Preparation Stage

Ty .-_':'d\I Bk "||
o | falw = Dhw 10

Order and description of the different stages of the split document

First stage: Preparation stage

Main TopSolid'Split operations: | 4 Positioning

% Molded shapes
%
& Shrinkage

Second stage: Parting stage

Main TopSolid'Split operations: X Shape to split

A Stock
*
% Parting edges

% Shut off surfaces

Candidate edges

Q/ Parting Surface

Third stage: Parting stage

Main TopSolid'Split operations: % Parting shells

@ Parting shapes

Ay
y.14
~ Core cavity blocks
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